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Figure 8-7 Exercise 4 (Manual Labeling) 

 
 
 

9. Adding Text To Your Theme 
ArcView has a variety of ways to place text a view or layout. Text is 
determined by you typing in the text you want to show. The following diagram 
shows the tools and examples of the kind of text added to a view: 

Figure 9-1 Adding Text 

 
 

We will demonstrate this section using PP District and PP Road Network 
themes. 

 
There are three main steps in this section: 

1. Adding text to your theme 
2. Using font palette 
3. Using color palette 

 

9.1. Adding Text to Your Theme 
1. Choose a text tool, position and click the cursor on your view where 

you want your text to begin. The text Property Dialog Box appear as 
below: 
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Figure 9-2 Text Tool 

 
 

2. Type the text into the Text Properties dialog and click OK. 
3. The picture below is showing the result of that, 
4. Try out every text button to enter your text into the view as indicated in 

the picture below 
Figure 9-3 Various Texts 

 
 

9.2. Using Font Palette 
With Font Palette, you can change your text name, text size and text style. 
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1. From Window menu Choose Show Symbol Window (or Ctrl + P) to 

bring up Palette Manage. 
Figure 9-4 Choose Show Symbol Window  

 
 

Figure 9-5 Palette Manager 

 
 

2. Click on the Text Button (see picture below) to switch to Font Palette, 
Figure 9-6 Font Palett 

 
 

3. Follow the steps indicated in the picture above to change the text name, 
text size and text style of “Text”. 

9.3. Using Color Palette for Text 
With the color palette, you can change color of your text. 

 
1. From the Palette Manager or Font Palette, Click on Color Button (see 

picture below) to switch to Color Palette, 
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Figure 9-7 Switch to Color Palette 

 
 

2. Follow the steps indicated in the picture above to change the text color 
of “Text”. 

 

9.4. Summary 
With this chapter you are able to: 

1. Add texts with different modes to your themes, 
2. Changing style of your texts using Text Palette, 
3. Changing text color using Color Palette. 

 

9.5. Exercise 5 
Add texts to the theme as indicated below: 

1. Tonle Sap River 
2. Mekong River 
3. Japanese Bridge 
4. Basak River 
5. Airport 
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Figure 9-8 Adding Texts 

 
 

10. Creating Your Layout: Creating Hard Copy Maps 
Layout is the document type used to create hard copy maps. Layouts are used 
as a master document in which views, tables and charts can be combined with 
map elements (e.g., legend, scale bar, north arrow) to design quality maps for 
output to plotters of graphic file formats. 

 
We will walk you through 13 steps for this section: 
1. Creating a New Layout 
2. Setting up Layout Scale 
3. Preparing Scale Bar for a Layout 
4. Preparing Legend for a Layout 
5. Editing Title for a Layout 
6. Adding Text to a Layout 
7. Using Graticule and Grid Extension 
8. Preparing North Arrow for a Layout 
9. Adding Picture to a Layout 
10. Adding View to a Layout 
11. Adding Graphics to a Layout 
12. Exporting a Layout to JPEG Image 
13. Printing Layout 
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The quickest way to make a layout is to have your view as the active 
document. So that you have to turn on all of your themes to make a view look 
like the one in the picture below. 

 
Figure 10-1 Ready View for Creating a Layout 

 
 

10.1. Creating a New Layout 
1. Choose Layout from the View Menu (see picture below).  

Figure 10-2 Choose Layout 
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2. The template dialog box appear, 

Figure 10-3 Template Dialog Box  

 
 

3. In this case choose Portrait template, 
4. Click OK. 

 
Automatically a layout look like the one below created in the layout 
environment. 
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Figure 10-4 Layout Result 

 
 

10.2. Setting up Layout Scale 
We are going to set up the scale for the layout.  In this case we want the scale 
to be 1: 150,000.  To get this follow the steps below: 

 
1. Double click on the view in the layout to bring up the View Frame 

Properties box as below, 
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Figure 10-5 View Frame Properties Box  

 
 

2. Make sure that your view name is selected in the View box, 
3. Live link is checked, 
4. Choose User specified Scale from the Scale box, 
5. In the box below the scale box type 150000 (without “,”), 
6. Click OK. 

 
Your layout view become like the one in the picture below. It is surrounded by 
small 8 black squares enabling you to expand only the extension of the view. It 
maintains the scale of the view. 

Figure 10-6 View Frame 

 
 

Use mouse pointer to expand the extension until you get the view displayed 
like the one in the picture below. 
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Figure 10-7 View Frame Result 

 

10.3. Preparing Scale Bar for the Layout 
By default, scale bar is made by using distance unit (Miles) with random 
interval value. In this case 4 Miles for an interval. But in this case we would 
like to have a scale bar with unit of Kilometers and interval value of 5 
Kilometers. Follow instruction below to change this: 

 
1. Double click on the scale bar to bring up the Scale Bar Property box, 

Figure 10-8 Scale Bar Properties 

 
 

 
 

 
44     Prepared by JICA Study Team 

 



ArcView Operation Manual 

2. Fill in the box as shown the picture above, 
3. Click OK. 
You will get a new scale bar as shown in the picture below. 

Figure 10-9 New Scale Bar 

 

10.4. Preparing Legend for the Layout 
1. Adding Legend Extension, File Menu > Extension, the Extension box 

appears. Check on Legend Tool as shown in the picture below. 
2. Click OK, 

Figure 10-10 Available Extensions 

 
 

3. The Custom Legend Tool appears in the layout tool bar as shown 
below:  

Figure 10-11 Custom Legend Tool Bar 

 
 

4. Click the tool and click once on the layout, the first Legend Tool Box 
appears as below, 

Figure 10-12 Legend Tool Box 

 
 

5. Click Next to bring up the second box as below, 
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Figure 10-13 Legend Tool Box (View Selection) 

 
 

6. In the Choose a view box, choose your layout view. In this case “Map 
of Phnom Penh City”, 

7. Move themes in the left box to the right one in the order as shown below 
using “>>”. 

8. In the next box, choose 2 for two-column legend. 
9. Click Next to bring the next box as below: 

Figure 10-14 Title of Legend 

 
This box will question you about the title of your legend. 

10. Answer the box as indicated in the picture above, 
11. Click Next to go to the next one, 

Figure 10-15 Border of Legend 
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This box consults you about border of your legend. 

12. Fill in the box as shown above, 
13. Click Next to walk on to the next one, 

Figure 10-16 Shape of Legend 

 
This is design to provide you different shape of you legend. 

14. Choose Rectangular for area symbol and Zig zag line for your line 
symbol, 

15. Click Next to go to the last one as below, 
Figure 10-17 Spacing of Legend 

 
 

16. This box is about the amount of space to be placed between elements of 
your legend. 

17. Choose Preview to view the legend you have just created, 
18. ArcView then shows you the legend according to the parameters you 

provide. If you don’t like the one choose Remove button to remove it 
and go back to change the setting. If it is OK for you just click on the 
Finish button to accept it. 

 
The result of the setting we have made is as below: 
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Figure 10-18 Legend for Your Layout 

 
 

10.5. Editing Title of a Layout 
Now we are going to edit the title of your map. We will give the map title: 
Landuse and Infrastructure Map of Phnom Penh, Cambodia. 

By default, the layout will title your map after your view name. In this case 
“Map Of Phnom Penh City” as in the picture below. 

Figure 10-19 Title of Layout 

 
 

1. Double click on the title to bring its associated text editor as below. 
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Figure 10-20 Title Text Editor 

 
 

2. Delete the current text and type “Landuse and Infrastructure Map of 
Phnom Penh, Cambodia” as in the picture above. 

3. Choose middle alignment, 1 for Vetical Spacing and 0 for Rotation 
Angle. 

4. Click OK. 
Below is the result of the editing: 

Figure 10-21 Edited Title 

 
 

10.6. Adding Text to a Layout 
Always, hard copy map would come with its description to inform the users 
about the purpose, data source of the map and so on. In this case we want to 
add description to our map as shown in the pictures below: 

Figure 10-22 Adding Text to a Layout 
Prepared by Ministry of Public Works and Transport (MPWT) 

 
         and 

 
 

1. Click on the text tool (see picture below) and then click once on layout 
where you want the description to be, 

Figure 10-23 Text Tool 
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The Text Editor Box Appears as below: 

Figure 10-24 Text Editor Box 

Prepared by Ministry of Public Works 
and Transport (MPWT) 

 
2. Type in the box as shown in the picture above and choose middle for 

the alignment. 
3. Click OK. 
You will see the description appears as shown in the first picture above. 

4. Follow the same to get the next one (as shown in the second picture). 

10.7. Adding Measure Grid to Your Layout View 
Measure grid is grid based on coordinate system. In this case we will add grid 
based on UTM coordinate system to our map layout. 

1. Load Graticules and Measure Grids Extension (see picture below), 
Figure 10-25 Load Graticules and Measure Grids Extension 

 
 

2. The Griticules and Grid button appears in the layout button bar, See 
picture below, 

Figure 10-26 Griticules and Grid Button  

 
 

3. Click on the button to bring up the measure grid box, see picture below. 
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Figure 10-27 Measure Grid Box (View Frame) 

 
 

4. Make sure that your view name is selected and Create a measure grid is 
checked. In this case “Map of Phnom Penh City”  

5. Click Next to go the option dialog box, 
Figure 10-28 Measure Grid Box (Grid Option) 

 
6. Fill in the box as in the picture above, 
7. Click next again to bring the border dialog. See picture below: 
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Figure 10-29 Measure Grid Box (Border Option) 

 
 

8. Fill in the box as shown in the picture above, 
9. ArcView then shows you the grid according to the parameters you 

provide. If you don’t like the one choose Remove button to remove it 
and go back to change the setting. If it is OK for you just click on the 
Finish button to accept it. 

 
The result of that look like the one in the picture below: 

 
Figure 10-30 Measure Grid Just Created 
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10.8. Preparing North Arrow 
By default, north arrow shows up like the one in picture below.  ArcView 
allows you to change its attribute: style, size and rotation angle. 

1. Double click on the arrow to bring up North Arrow Manager Box, 
Figure 10-31 North Arrow 

 
 

Figure 10-32 North Arrow Manager 

 
 

2. From the box you can choose your desired one. In this case we choose 
the arrow indicated in the box above, 

3. Accept 0 degree for the rotation angle, 
4. Click OK to accept it. The arrow we have chosen appeared as in the 

picture below,  
Figure 10-33 North Arrow (Result) 

 
5. To change size the arrow, position your mouse on a point surrounding 

the arrow, drag to desired size, then drop it. 
 

10.9. Adding a Picture to a Layout 
Now, we will illustrate to add MPWT logo to the layout as an image. 

1. Click and hold the View Frame tool to display the hidden tools, 
2. Choose Picture Frame tool, see picture below, 
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Figure 10-34 Picture Frame Tool 

  
3. Drag and Drop the tool on the layout see picture below, Picture Frame 

Property box appears. 
Figure 10-35 Drag and Drop the Tool 

 
 

Figure 10-36 Picture Frame Property Box 

 
 

4. Click Browse button to open the Open File box, 
Figure 10-37 Open File Box 

mpwt

mpwt

mpwt.logo

 
 

5. Go to the location shown in the picture above: 
e:\mpwt\pasco\mpwt.logo, 

6. Select image file Logo.tif, 
7. Click OK to complete the box below, 

 
54     Prepared by JICA Study Team 

 



ArcView Operation Manual 

Figure 10-38 Load an Image 

 
 

8. Click OK to load the image into our layout as below. 
Figure 10-39 Loaded Image 

 

mpwt 

10.10. Adding View to Layout 
In our map, we need other view to show the location of Phnom Penh area 
compared to the country. In this case we arc going to add location view into 
our map. This view has to prepare in advance in the view. 

 
1. Click on the View Frame tool, see picture below, 

 Figure 10-40 View Frame Tool 

 
 

2. Use the tool to drag and drop in the lower right corner of the layout 
view as in the picture below, 

Figure 10-41 Drag and Drop the Tool 

 
 

The View Frame Property box appeared as below: 
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Figure 10-42 View Frame Property 

 
3. Choose the Location View, 
4. Click OK, you can see the location view now added to the layout as in 

the picture below. 
Figure 10-43 Adding to a Layout 

 
 

10.11. Adding Graphic to Layout 
Now we want to add a frame to the location view. 

1. Click on Draw Rectangle tool, see picture below, 
Figure 10-44 Draw Rectangle Tool Box 

 
 

2. Drag-drop the tool around the location view as in the picture below, 
Figure 10-45 View Location 
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10.12. Exporting a Layout to JPEG Image 
Some time we want to use the layout in another program such as MS Word, 
Excel and so on. Below will demonstrate how to export the layout as an image 
file (JPEG file). 

1. Choose Exprt from File Menu, see picture below, 
Figure 10-46 File Export 

 
 

2. The Open File Dialog box appeared: 
Figure 10-47 Open File Dialog Box 

mpwt

mpwt

 
 

3. Click on the Option button to change the attribute of the exported file. 
4. The Property box appeared as below, 

Figure 10-48 Setting Options 

 
 

5. Type 200 for the Resolution and 100 for quality, 
6. Click OK, 
7. In the Open File box, choose your directory as destination location, and 

PP-map.jpg as your file name. 
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Figure 10-49 Saving a JPEG File 

mpwt

mpwt

 
 

8. Click OK to accept the setting, 
9. Now, we have already exported the layout to and PP Map.jpg file. 

 

10.13. Printing a Layout 
Now it is time to print our layout as a hard copy map. The step below will help 
us to do that. 

 
1. Click on Print Button to bring up the Print Dialog box, 

Figure 10-50 Open Print Dialog Box 

 
 

2. On the Print Dialog box, click on Setup... button, 
Figure 10-51 Print Dialog Box 

 
 

3. Here we have to check on: 
Printer name, in this case Canon Bubble Jet BJC-4200, • 

• 
• 
• 

Paper size, choose A4, 
Orientation, Choose Landcape, 
Click OK to accept the setting, 
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Figure 10-52 Set Print Options 

 
 

4. Click OK again to print the layout. 
Figure 10-53 Print 

 

10.14. Summary 
With this chapter you are able to: 

1. Create a new layout from a view you are working with, 
2. Set up desire scale for you hard copy map, 
3. Make up scale bar for your hard copy map, 
4. Create legend for your hard copy map, 
5. Add title and other text as description for your hard copy map, 
6. Create grid to your map extension of your layout, 
7. Add a selected north arrow to your layout, 
8. Add new views, drawing graphics and images to your layout 
9. Print your layout as hard copy map. 

 

10.15. Exercise 6 
Prepare your layout to be like the one below: 
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Figure 10-54 Exercise 6 (Layout) 

 
 
 

11. Working with Tabular Data 

11.1. What is a Table? 
A table is tabular data representation environment. Table contains descriptive 
information about a specific entity.  Below is an example of an ArcView 
Project’s table. 

Figure 11-1 ArcView Project’s Table 

 
 

We are going to create a ArcView table like the one below.  
Table 11-1 Sample Table 

X_coor Y_coor School Student 
490000 1285200 Ruessei Kaev 257
485000 1277800 Dangkao 578
489900 1277900 Tuol Kouk 341
491600 1279500 Doun Penh 587

 
There are eight steps in this tutorial: 

1. What is a Table? 
2. Creating a New Table 
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3. Adding Fields to Your Table 
4. Adding Records to Your Table 
5. Typing Data into a Table 
6. Loading a bBase files into Arcview tables 
7. Making Statistic from a Table 
8. Summarizing a Table 

11.2. Creating a New Table 
1. Go to project Window, 
2. Highlight the table object, 
3. Click on the New button to create a new table, 

Figure 11-2 Creating a New Table 

 
 

4. The New Table dialog box appears prompting you for the new table file 
name and its location. See picture below, 

Figure 11-3 Saving a Table File 

mpwt

mpwt

 
5. Give School Location.dbf for the file name and choose your directory 

for its location. 
6. Click OK, the new empty table created as shown in the picture below. 

Figure 11-4 Table 
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11.3. Adding Fields to Your Table 
To add its record follows this: 

1. Choose Add Field... from Edit Menu, see picture below, 
Figure 11-5 Adding Fields 

 
 

2. The Add Field Dialog box appears, 
Figure 11-6 Add Field Dialog Box 

 
3. Type X_coor for the Name, 
4. Choose Number as Type, 
5. Type 6 for With, 
6. Type 0 for Decimal Places, 
7. Click OK, the field added as shown in the picture below. 

Figure 11-7 Field Added 

 
 

Continue to add three more fields: Y_coor, School and Student 

8. For Y_coor field: 
Type Y_coor for the Name, 
Choose Number as Type, 
Type 7 for With, 
Type 0 for Decimal Places, 

9. For School field: 
Type School for the Name, 
Choose String as Type, 
Type 20 for With, 
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Type Student for the Name, 
Choose Number as Type, 
Type 4 for With, 
Type 0 for Decimal Places, 

 
The result of that is shown in the picture below. 

Figure 11-8 Adding Fields Completed 

 
 

11.4. Adding Records to Your Table 
Now we are going to add four records to the table.  

1. Choose Add Record from Edit Menu (or Ctrl+A). 
Figure 11-9 Adding Records 

 
 

2. Repeat four times until we get four records added to the table like the 
one in the picture below. 

Figure 11-10 Add More Records 

 
 

11.5. Typing Data into a Table 
To type data into table, here are the way: 

1. Click on the Edit tool, see picture below, 
Figure 11-11 Edit Tool 
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2. Click on upper-left cell, then the cell become editable, 

Figure 11-12 Editable Table 

 
 

3. Start to type in the cell, in this case 490000, and then continue until you 
get a table shown in the picture below. 

Figure 11-13 Data Entry 

 
 

4. After you complete entering the text, stop editing the table by Choosing 
Stop Editing from Table Menu. See picture below. 

Figure 11-14 Stop Editing 

 
 

5. ArcView then will prompt you whether you want to save the changes 
you have made or not. Click Yes to save it. See picture below. 

Figure 11-15 Saving Edited Entry 

 
 

11.6. Loading a bBase File into Arcview tables 
Some time we need to add dBase files created by another program. In order to 
do this we have to: 
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1. From the project window with the Tables object selected, click on Add 
button. See picture below. 

Figure 11-16 Loading dBase File 

 
 

2. In the Add Table dialog box below, choose Landuse.dbf from 
...\covers\legend. See picture below, 

3. Click OK. 
Figure 11-17 Add Table Dialog Box 

mpwt

mpwt

 
 

The landuse.dbf file appears. 
Figure 11-18 Landuse.dbf File 

 
 

11.7. Making Statistic from a Table 
There is a function in ArcView that let you compute statistical parameters form 
a numerical field. That is Statistical function. 

We arc going to calculate statistical parameters from Student field in the table 
shown in picture below. 
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Figure 11-19 Selecting a Field 

 
 

1. Select the Student field in the table, 
2. Choose Statistics from Field Menu, 

Figure 11-20 Select Statistics 

 
3. The parameters is calculated and displayed as can be seen in the 

picture below. 
Figure 11-21 Statistics Output 

 
 

11.8. Summarizing a Table 
SUM function in ArcView let you summary a numerical field base on its 
characteristic from another field. 

The following, we arc going to sum length of drainage based on their 
characteristic from Description field. 

Select the Description field in the attribute table of Drainage, 
Figure 11-22 Selecting a Description Field 
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1. Click on Summarize button, see picture below, 

Figure 11-23 Click on Summarize 

 
 

2. In the result of the function ArcView will create another table. So it now 
prompts you for the name and location of the resulting table. Click Save 
As button to give the file name and new location, 

Figure 11-24 Define a File Name 

 
Give CanalLengh.dbf as file name and your location directory as its location. 
See picture below. 

Figure 11-25 CanalLength.dbf 

mpwt

mpwt

 
 

3. Choose Length from Field option, Sum from Summarize by option, 
4. Click OK. 

Figure 11-26 Choose Options 
mpwt 

 
 

This picture shows the result of drainage length by their attribute. 

Prepared by JICA Study Team     67 



ArcView Operation Manual 

Figure 11-27 Result of “Summarize” 

 

11.9. Summary 
With this chapter you are able to: 

1. Creating a New Table, 
2. Add Fields to Your Table, 
3. Add Records to Your Table, 
4. Type Data into a Table, 
5. Load a bBase files into Arcview table, 
6. Make Statistic from a Table, 
7. Summarizing a Table by map feature attribute. 

 

11.10. Exercise 
1. Create a new ArcView table like the one below:  

 
No. DISTRICT VILLAGE MALES FEMALES PERSONS 

1 Aoral Krang Kok 115 134 249 
2 Phnum Sru Thmei 296 320 616 
3 Phnum Sru Chambak 93 97 190 
4 Phnum Sru Krang Kor 306 296 602 
5 Chhuk Srae Leav 71 77 148 
6 Chhuk Trapeang 144 152 296 
7 Kien Svay Srae Ampi 1033 1075 2108 
8 Kaoh Thum Chrouy Sn 458 432 890 
9 S'ang Lekh Buon 606 672 1278 

10 Angkor Bo Preaek Da 405 392 797 
11 Angkor Bo Tuol Putr 442 444 886 
12 Angkor Bo Phnum Bor 522 535 1057 
13 Angkor Bo Ba Tep 151 159 310 

 
1) District: District Name 
2) Village: Village Name 
3) Males, Females and Persons: Total Number of Male, Female and Person in 

the village. 
2. Summarize number of male, female and person on the 13 districts. 
3. Summarize number of male, female and person by district. 
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APPENDIX 

1.  INDEX 
PROJECTION: UTM, Meters, Zone: 48, Spheroid: Everest 1830, 

Datum: Indian 1954 
FEATURE TYPE: POLYGON 
DESCRIPTION: Index Boundary (Topo map 1:100,000)  
LOCATION: Sheet Location 
SHEET_NUMBER: Number of 1:100,000 topo sheets 
SHEET_NAME: Name of 1:100,000 topo sheets 

 
2.  POP_SHP 
PROJECTION: UTM, Meters, Zone: 48, Spheroid: Everest 1830, 

Datum: Indian 1954 
FEATURE TYPE: POLYGON 
DESCRIPTION: Polygons describing the extents of built-up areas, 

villages, cemeteries, airfields or other special man-
made features. 

CODE: Code Number 
 

CODE DESCRIPTION: 

CODE (2) DESCRIPTION 
0 Holes or complex polygons within this data set (not drawn) 

22 Built-up Area 
23 Village (with a high density of structures) 
24 Village (with a medium density of structures) 
25 Village (with a low density of structures) 
36 Cemetery 
39 Airfield 
42 Floating Village (with a high density of structures) 
43 Floating Village (with a medium to low density of structures) 
45 Dock or Pier 

225 Large areas of numerous low density villages 
 

3. RD_LIN 
PROJECTION: UTM, Meters, Zone: 48, Spheroid: Everest 1830, Datum: 

Indian 1954 
FEATURE TYPE: LINE 
DESCRIPTION: Roads and road related line data 
CODE: Code Number for each feature 
 

CODE DESCRIPTION: 

CODE DESCRIPTION 
1 All weather, hard surface road, two or more lanes wide 
2 All weather, hard surface road, one lane wide 
3 All weather, loose surface, two or more lanes wide 
4 All weather, loose surface, one lane wide 
5 Dry weather, loose surface 
6 Cart track 
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7 Footpath 
8 Streets in built-up areas 

60 Ferry 
61 Ford 

 
4. RD_CART 
PROJECTION: UTM, Meters, Zone: 48, Spheroid: Everest 1830, Datum: Indian 

1954 
FEATURE TYPE: POINT 
DESCRIPTION: Road related cartographic point data 
CODE: Code Number 
 

CODE DESCRIPTION: 

CODE DESCRIPTION 
9 Rout Maker (National) 

10 Rout Maker (Other National) 
11 Traffic Circle 

 
5. RD_DIRECTION 
PROJECTION: UTM, Meters, Zone: 48, Spheroid: Everest 1830, Datum: 

Indian 1954 
FEATURE TYPE:  POINT 
DESCRIPTION: points for road direction arrows along map sheet 

boundaries 
KHMER_STR: Khmer Text String 
ROMAN_STR: Roman Text String 
TYPE DESCRIPTION: No unique identifier, not useful as a CODE 

 
6. RD_PTS 
PROJECTION: UTM, Meters, Zone: 48, Spheroid: Everest 1830, Datum: 

Indian 1954 
FEATURE TYPE:  POINT 
DESCRIPTION: Roads and Related Point Data 
DATABASE SCHEMA 
DEFINITION: 

 

CODE: Code Number 
 

CODE DESCRIPTION: 

CODE DESCRIPTION 
12 Bridge 
13 Footbridge 
60 Ferry  
61 Ford 

 
7. RR_LIN 
PROJECTION: UTM, Meters, Zone: 48, Spheroid: Everest 1830, Datum: Indian 

1954 
FEATURE TYPE: LINE 
DESCRIPTION: Railroads and rail line data 
CODE: Code Number for each feature 
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CODE DESCRIPTION: 

CODE DESCRIPTION 
16 Railroad Track 

 
8. RR_PTS 
PROJECTION: UTM, Meters, Zone: 48, Spheroid: Everest 1830, Datum: Indian 

1954 
FEATURE 
TYPE: 

POINT 

DESCRIPTION: Railroad related point data 
CODE: Code Number 
 

CODE DESCRIPTION 

CODE DESCRIPTION 
17 Railroad Station 
18 Railroad Bridge 

 
9. HIS_SITE 
PROJECTION: UTM, Meters, Zone: 48, Spheroid: Everest 1830, Datum: Indian 

1954 
FEATURE 
TYPE: 

POINT 

DESCRIPTION: Additional Historical Sites 
CODE: Unique Feature ID (concatination with sheet number) 
NAME: Name of the site in Roman Characters  
 

TYPE DESCRIPTION: 

CODE DESCRIPTION 
NA Basically a unique identifier, not useful as a CODE 

 
10. TOPO_PTS 
PROJECTION: UTM, Meters, Zone: 48, Spheroid: Everest 1830, Datum: Indian 

1954 
FEATURE 
TYPE: 

POINT 

DESCRIPTION: Topographic features described as points 
 

CODE DESCRIPTION: 

CODE DESCRIPTION 
94 Small Hill 

 
11. POP_CART 
PROJECTION: UTM, Meters, Zone: 48, Spheroid: Everest 1830, Datum: Indian 

1954 
FEATURE 
TYPE: 

POINT 

DESCRIPTION: Infrastructure cartographic point features 
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CODE DESCRIPTION: 

CODE DESCRIPTION 
44 Grounds/Playgrounds/Stadiums 

 
12. POP_PTS 
PROJECTION:  UTM, Meters, Zone: 48, Spheroid: Everest 1830, Datum: Indian 

1954 
FEATURE 
TYPE: 

POINT 

DESCRIPTION: Infrastructure point features 
 

CODE DESCRIPTION: 

CODE DESCRIPTION 
21 Buildings 
26 Khet Office and Krong Office 
27 Srok Office and Khan Office 
28 Khum Office 
29 Temple 
30 School 
31 Church 
32 Mosque 
33 Stupa 
34 Post Office 
35 Hospital 
37 Historical Site 
38 Light House 
40 Mine 
41 Port 

 
13. CON_LIN 
PROJECTION: UTM, Meters, Zone: 48, Spheroid: Everest 1830, Datum: Indian 

1954 
FEATURE TYPE: LINE 
DESCRIPTION: Contour Lines 
CODE: Code Number for each feature 
SPOT: Contour value in Meter 
 

CODE DESCRIPTION: 

CODE DESCRIPTION 
112 Index Contour 
113 Intermediate Contour 
114 Suppementary Contour 
115 Depression Contour 

 
14. CON_PTS 
PROJECTION: UTM, Meters, Zone: 48, Spheroid: Everest 1830, Datum: Indian 

1954 
FEATURE TYPE: POINT 
DESCRIPTION: Control Points, Benchmarks, and Spot Elevations 
CODE: Code Number 

 
72     Prepared by JICA Study Team 

 



ArcView Operation Manual 

SPOT: Spot Elevation in Meter (20m interval) 
 

CODE DESCRIPTION: 

CODE DESCRIPTION 
101 Horizontal Control Point (established after 1990) 
102 Horizontal Control Point (established before 1990) 
103 Bench Mark (established before 1990) 
104 Spot Elevation in Meter 
106 Bench Mark (established after 1990) 

 
15. GPS_POINT 
PROJECTION: UTM, Meters, Zone: 48, Spheroid: Everest 1830, Datum: Indian 

1954 
FEATURE TYPE: POINT 
DESCRIPTION: additional benchmark related data 
CODE: Unique Feature ID 
TYPE: Type as Defined by Benchmark Layer 
LONG1: Longitude Minutes 
LONG2: Longitude Seconds 
LAT1: atitude Minutes 
LAT2: atitude Seconds 
UTM-X: TM Easting 
UTM-Y: TM Nothing 
HEIGHT: levation (if known) of the point   
 

TYPE DESCRIPTION: 

TYPE DESCRIPTION 
102 Horizontal Control Point (established before 1990) 
103 Bench Mark (established before 1990) 
104 Spot Elevation in Meter 
106 Bench Mark (established after 1990) 
107 Unknown 

 
16. GEOLOGY  
PROJECTION: TM, Meters, Zone: 48, Spheroid: Everest 1830, Datum: Indian 

1954 
FEATURE 
TYPE: 

OLYGON 

DESCRIPTION: eology/Landforms 
GEO100K: odes for 1:100,000 Scale Data 
GEO500K: odes for 1:500,000 Scale Data 
RELATED 
DATA FILE: 

EOLOGY.LEG 

RELATED 
ITEM: 

EO500K 

 

 

 

 

Prepared by JICA Study Team     73 



ArcView Operation Manual 

GEO500K DESCRIPTION: 

GEO50K LEGEND
_CODE CATEGORY LEGEND_EG 

1 W Landform Water 
2 Fp Cenozoic Floodplains 
3 Af Cenozoic Alluvial fans 
4 Co Cenozoic Colluvial (Tallus conces) 
5 Pd Cenozoic Pediments 
6 Lb Cenozoic Lakebeds 
7 Db Cenozoic Deltaic deposits 
9 Br Cenozoic Levees 

10 Sw Cenozoic Organic deposits (swamps) 
12 Ap Cenozoic Alluvial plains 
14 Ta Cenozoic Terrace allivial 

105 Jac Mesozoic claystone 
106 JCg Mesozoic Sandstone 
107 JCcg Mesozoic Conglomerates 
108 J Mesozoic Sandstone 

109 J1-2 Mesozoic Red Terrane (reddish brown 
sandstone, siltstone and marl 

111 Tg Mesozoic Formation (sandstone and micro-
breccias) 

112 Tx Mesozoic Formation (siltstone, schists and 
marl) 

115 CP Pareozoic Limestone 
116 DC Pareozoic Black shists, phtanites, sandstone 
117 DHj Pareozoic Phtanites 
118 DHx Pareozoic Shists and sandstone 
123 CS2q Pareozoic quartzites 
124 Csq Pareozoic quartzites 
125 CSx Pareozoic schists 
126 CScg Pareozoic metaconglomerates 

201 C Unknown 
Geologic Era hornfels 

303 p2/p2b Volcanic Rocks rhyolites and rhyodacites 
305 b Volcanic Rocks dacites 
306 p1 Volcanic Rocks rhyolites 
307 p Volcanic Rocks rhyolites 

308 α1 Volcanic Rocks trachyte, andesites, andestes and 
tuffs 

309 α Volcanic Rocks andesites, andesitic breccias and 
tuffs 

310 r2t Volcanic Rocks Volucano-sedimentary breccias 
and acidic tuffs 

311 r1t Volcanic Rocks acid tuffs 
401 g4 Pultonic Rocks high alumina granite 

402 g3 Pultonic Rocks granite or g3-4 coarse grainded 
granites 

404 g3-2 Pultonic Rocks fine grained granites 
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407 g2 Pultonic Rocks granite 
409 gb Pultonic Rocks granodiorite 

999 NC No Classified 
Rocks No Classified Rocks 

 
17. LANDUSE 
PROJECTION: TM, Meters, Zone: 48, Spheroid: Everest 1830, Datum: Indian 

1954 
FEATURE TYPE: OLYGON 
DESCRIPTION: anduse data as interpreted from LandSAT TM imagery 
LU_CODE: anduse Code Number 
TOPO_CODE: opographic Map Landuse Code Number (see TOPO_LANDUSE 

entry) 
RELATED DATA 
FILE: 

ANDUSE_TEXT 

RELATED ITEM: U_CODE 
 

LUCODE DESCRIPTION: 

LU 
CODE 

CLASSIFIC
ATION CATEGORY NAME 

1 U Urban, Built-up 
Areas 

Settlement 

2 I Urban, Built-up 
Areas 

Infrastructure (Airfield, factory, 
etc.) 

3 Ar Agricultural lands Paddy field 
4 Al Agricultural lands Receding and Floating rice 

fields 
5 Au Agricultural lands Field crop 
6 As Agricultural lands Swidden agriculture (Slash and 

burn) 
7 Ao Agricultural lands Orchard 
8 Ap Agricultural lands Plantation (Rubber plantation) 
9 Av Agricultural lands Village garden crop 

10 Ag Agricultural lands Garden crop 
11 Arv Agricultural lands Paddy field with villages 
12 G Grasslands Grassland (undifferentiated) 
13 Ga Grasslands Abandoned field covered by 

grass 
14 Gf Grasslands Flooded grassland 
15 Gs Grasslands Grass Savannah 
16 Gm Grasslands Grass with termite mounds 
17 Ms Grasslands Marsh and swamp 
18 S Shrublands Shrubland (undifferentiated) 
19 Sa Shrublands Abandoned field covered by 

shrub 
20 Sf Shrublands Flooded shrub 
21 St Shrublands Woodland and scattered trees (C 

< 10%) 
22 Fe Forest covers Evergreen broad leafed forest 
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23 Fc Forest covers Coniferous forest 
24 Fd Forest covers Deciduous forest 
25 Fdo Forest covers Dry Deciduous (Open) forest 
26 Fx Forest covers Mixed forest from evergreen 

and deciduous species 
27 Fr Forest covers Riparian forest 
28 Fs Forest covers Bamboo and Secondary forests 
29 Ff Forest covers Flooded forest 
30 Fm Forest covers Mangrove forest 
31 Fmd Forest covers Degraded mangove forest 
32 Fp Forest covers Forest plantation 
33 Wl Water Features Lakes (>8 ha) 
34 Wp Water Features Lakes (<8 ha) 
35 Wr Water Features Reservoir 
36 Ws Water Features Shrimp/Fish farming and Salt 

pan 
37 Wo Water Features Others (Sea, Bay, etc.) 
38 B Soils and Rocks Barren land 
39 Bs Soils and Rocks Sand bank 
40 Br Soils and Rocks Rock outcrop 

 
18. LU_TOPO 
PROJECTION: TM, Meters, Zone: 48, Spheroid: Everest 1830, Datum: Indian 

1954 
OLYGON 
anduse grouped and dissolved for topographic maps 
opographic Map Landuse Code Number  

FEATURE TYPE: 
DESCRIPTION: 
TOPO_CODE: 
 

TOPO_CODE DESCRIPTION: 

TOPO_CO
DE DESCRIPTION 

53 Lake or Pond 
55 Salt Evaporator 
51 Open Water (oceans, large lakes and rivers) 
91 Rock Outcrops 
96 Sand Terrain 
98 Barren Land 

151 Dense Frest or Jngle 
152 Clear Forest 
153 Shrubland 
155 Plantation 
156 Flooded Grassland 
157 Flooded Shrub 
158 Flooded Forest 
159 Marsh or Swamp 
160 Rice Field 
161 Mangrove 
162 Field Crops 
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163 Swidden Agriculture 
164 Grassland 
165 Orchards 
166 Village Garden Crops 
167 Receding Rice Fields and Floating Rice Fields 
169 Urban, and Built-up Areas 

19. DN_LIN 
TM, Meters, Zone: 48, Spheroid: Everest 1830, Datum: Indian 
1954 

FEATURE TYPE: INE 
ater and water related line features 

CODE: ode Number for each feature 

 

 

PROJECTION: 

DESCRIPTION: 
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CODE DESCRIPTION: 

CODE DESCRIPTION 
51 River/Stream (permanent water) 
52 Intermint River/Stream (temporal or intermittent water) 
53 Arcs from polygon features (not drawn) 
54 Arcs from polygon features (not drawn) 
55 Arcs from polygon features (not drawn) 
56 Canal Small 
57 Canal Large 
64 Levee 
65 Concrete of Stone Revetment 
69 Abondoned Canal 

 
20. DN_POL 

TM, Meters, Zone: 48, Spheroid: Everest 1830, Datum.: Indian 
1954 

FEATURE 
TYPE: 

OLYGON 

ater and water related polygon features 
CODE: ode Number 

CODE DESCRIPTION: 

CODE DESCRIPTION 
0 

51 River/Stream (perennial or permanent water) 
52 

Lake or Pond (perennial) 
54 Lake or Pond (temporal) 

Salt Evaporator 
 

21. DN_PTS 
PROJECTION: 

FEATURE 
TYPE: 

OINT 

DESCRIPTION: 
Code Number 

 

CODE DESCRIPTION: 

CODE 
Eastern Dam 

67 Water Tower/Tank 

 
 

PROJECTION: 

DESCRIPTION: 

 

Holes or Complex Poloygons within this data set  (not 
drawn) 

Intermittent River/Stream (temporal or intermittent water) 
53 

55 

UTM, Meters, Zone: 48, Spheroid: Everest 1830, Datum: Indian 
1954 

Water related point features 
CODE: 

DESCRIPTION 
63 
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